
System Requirements

SoundSaVR 2.0 requires a Macintosh PowerPC or compatible system with a base requirement of 5
MB of RAM and 5 MB of hard disk space for installation. The sounds and VR movies used will
require additional hard disk space and memory. A recommended system configuration for adding
sounds to VR movies is 16 MB RAM and 50 MB of hard disk space. SoundSaVR requires
QuickTime 3.0 to be installed (version 4.12 strongly recommended), and requires System 8 or
higher.  Sound Manager 3.3 should also be installed as some compression codecs require it.

Usage Notes

Adding sounds using SoundSaVR should be the last step in the QTVR authoring process. This is
due to a special flattening process that permits QuickTime to loop sounds without storing it multiple
times. As QuickTime editing software calls the default QuickTime flattening function, when a
SoundSaVR movie is re-flattened it will grow in size. Only SoundSaVR is capable of flattening
SoundSaVR movies.

Modifications using other editors such as Movie Player will work as long as the movie is not flat-
tened.  To flatten the movie, open it with SoundSaVR and save the movie again.

SoundSaVR 2.0 tries to preserve embedded media such as custom graphics and wired sprites. Some
problems may be found with Flash and LiveStage media.  Test your output movies.   Multinode
movies with object nodes are now supported, but sounds can not be added to the object nodes.

Developers who are using authoring packages with scripting capabilities such as Director or
mTropolis, should take note that each node is set to a length of approximately one hour so that
sounds can independently loop.
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Welcome to SoundSaVR®, the wired sprite QTVR editing tool that
embedsdirectional sound into single or multinode panorama movies.

( Macintosh PPC only )



Quick Start

 Launch SoundSaVR
 Open a QTVR movie

 Add sounds to all nodes (unless a node is an object)
Select a node in the movie (repeat as necessary)

Import required sound files (repeat as necessary)
Click the "Add Sound..." button
Choose a sound file from the dialog
Repeat until all required sounds have been imported

Preview the sound settings ( as often as desired during the steps below)
Select the "Preview Mode"
Pan and Listen
Select the "Edit Mode"

Set the correct direction for sounds that should pan
Select a sound from the "Sounds" list box
Pan the movie to the desired angle
Click the "Set Angle" button
Repeat until all directional sounds have been set correctly

Set the volumes for each sound
Select a sound from the "Sounds" list box
Drag the volume slider(s) to the desired level
Repeat until all sound volumes have been set as desired

 Save the output movie
 Select "Save A Copy As...." menu item from the "File" menu
 Choose the file destination from the dialog



The Menu Bar

There are two active menu bar items in SoundSaVR: File and Options.

The File menu has five active items:
"Open...", "Close",  "Save A Copy As...",  and "Quit"

The "Open... " menu item will open a dialog to select a movie file.  Importing a file that has no
panorama track or QTVR track will cancel the process and the user will be notified that the file was
not a panorama.  When a valid QTVR movie has been selected, a SoundSaVR editing window will
open, displaying the selected movie file.

The "Close" menu item will close the active editing window.  If the movie has been edited, and the
changes haven't been saved, a dialog will open prompting the user to save before closing the movie,
to close without saving, or to cancel.

The "Save A Copy As..." menu item will open a standard put-file dialog allowing the user to save
the current movie with edited sounds.  It is recommended that users do not try to overwrite already
existing files.

The "Export..." menu item is only available if a NodeSaVR registration key is installed.  See your
NodeSaVR documentation for usage.

The "Quit" menu item will close all editing windows and Quit the application.  As with the Close
menu item, the user will be prompted to save any changes.

The Options menu has nine active items: the first two, "Degrees" and
"Cross Hairs", toggle the info displays on and off.  The remaining six
menu items set the color of the information displays.

The info displays use the dimensions of the panorama track, not the
entire movie, and are therefore always placed in their correct positions
even if a panorama track has been rotated or if additional media
elements have been added to the movie.

The Editing Window

Only one SoundSaVR editing window can be
opened at a time.  Clicking the windows
"zoom box" will reset the window to its origi-
nal size if it has been changed.



The Editing Panel
Each window contains an editing panel on the left side, that has a
"Node List", and "Sound List",  as well as buttons to add or delete
sounds, and controls that set the volume(s), type (ambient or direc-
tional), and looping status of each imported sound.

Add Sound... Button
Clicking on this button will open a dialog box where an appropriate
sound file can be selected in the get-file list box.  Clicking on this
button will open a dialog box where an appropriate sound file can be
selected in the get-file list box.  Clicking on Open will import the
selected sound into the current node and display it in the 'Sounds' list
box.  Previously grayed out items in the SoundSaVR editing panel
will become active.  If a sound file (that is not in a QT movie) can
be played back in QT3.0, the Open button will change to Convert.
Clicking on the button will convert the file to a QT movie, save the converted movie to a specified
file/directory, and then import it into the current node. To add an RTSP track, first save the RTSP
movie to your hard-drive.  From the plug-in choose "Save As QuickTime Movie..." or from
QuickTime Player choose "Save As..." and then "Make movie self-contained".  Then just add it like
any other sound.

Remove Sound Button
Clicking this button will remove the currently selected sound from the 'Sounds' list.  This button will
be grayed out if the Clicking this button will remove the currently selected sound from the 'Sounds'
list.  This button will be grayed out if the currently selected node has no sounds.

Nodes List
There will be only one item in this list if a single node pano is open. If it is a multinode pano, the
name of each node contained in the movie will  be displayed.  Clicking on a node list item will
select it as the current editing node and the sounds list box will be updated accordingly to reflect any
sounds that may have been embedded.

Sounds List
This list box will be grayed out until at least one sound file is imported into the current editing node.
To import a sound file, use the 'Add Sound...' button.  Clicking on a "Sounds" list item will select it
as the current editing sound, and update the sound setting controls accordingly.  If the currently
selected sound is set to be directional, then the movie screen will be updated to display the corre-
sponding view.  More than one sound can be imported into each node, as long as there is enough
available memory.  However, keep in mind that too many sounds in a node can confuse the listener.

Auto Play Button
If this check box is selected, the audio for the current node will automatically start playing whenever
the end user enters the node. If this option is not selected you will need to include an external
mechanism to start the sound.



Ambient Sound
If the "Directional Sound" check box for a particular sound is not checked, the  sound is considered
to be ambient and its volume will not change based on the pan angle.  This is the default state of
imported sounds.
Setting Ambient Sound Volume.

Ambient sound volumes are set using a single control slider in the "Volume" section of the editing
panel.  Drag the slider thumb to the desired sound level to set playback volume.  The volume is
represented as a range from -50 to 150 with the default being 100.  The current volume level is
displayed in the upper right of the Volume section.

Directional Sound
An imported sound is considered to be directional (that is, the sound
volume changes based on the pan angle) if the "Directional Sound"
check box is checked.  The current pan angle is used when clicking on
this check box.  When this box is  checked, the Volume section of the
editing panel will display a second volume control slider and label the
controls "Front" and "Rear" respectively

Setting a Sounds Direction
The direction of a sound can be changed in two ways:  by clicking the "Directional Sound" check
box (only the first time) or by clicking the "SET ANGLE" button after panning to the desired view.

Setting Directional sound volumes
When the current sound to be edited is a directional sound, the
"Volume" section of the editing panel displays two control sliders
and corresponding labels "Front" and "Rear".

The slider labelled 'Front' indicates the volume that will be used when the pan angle
matches the set direction of the sound source. The slider labelled 'Rear' indicates the volume that
will be used when the pan angle is 180 degrees away from direction of the sound source.

The volume level can range from -50 to 150.  Zero to 100 represents an even fall off all the way
around the panorama with 180 degrees away from the set direction being inaudible.  Setting the Rear
volume lower than 0 produces a narrower volume fall off for a directional sound.  Setting the Front
volume higher than 100 amplifies sound sources if they were too quiet when originally sampled.

Looping Style Check Box
Selecting this check box will enable the Looping Style Pop Up Menu.
When this box is not selected the sound will be played only once.

Looping Style Pop Up Menu
Selecting an item will determine the loop state of the currently selected sound to indicate type of
loop generated for playback.
    Continuous will play the sound repeatedly for the entire duration of the current node.
    Random Delay will play the sound repeatedly with random length silence between plays.



Edit / Preview Pop Up Menu
This menu allows added sounds to be played in preview mode.  The sound
volume settings can be changed "on the fly" while in preview mode.  The
direction can also be changed while in preview mode, but to add more sounds or change the looping
style the menu must be set to edit mode.

Known Issues

1) Multinodes which contain object nodes are now supported but you can not add sounds to the
object nodes. This is due to the differences between the format of object movies, and panoramic
movies. There are no plans to add sounds to object nodes, as QuickTime currently does not have
support for asynchronous track playback in one self-contained movie. As a result, this issue will not
be addressed by SoundSaVR.

2) Embedded media such as Flash and LiveStage may cause problems.

3) Adobe Go-Live requires the "GoLive CyberMovie Module." or your computer may crash during
uploads.

SoundSaVR Tips & Tricks
3D Sound Multinode Trick
1 Decide on a sound  "location" in a given node (i.e.. telephone).
2 Select a node that is the farthest away from the sound "location", and where you would like the
sound to still be heard.
3 Import a sound sample with a relatively short duration, set it to loop, and set the direction to point
to the sounds "location".
4 Set the "Front" volume to 50% (for example) and the "Rear" volume to something less than the
"Front" volume.
5 Repeat steps 3 & 4 for any node that is "closer" to the sound "location", adjusting the "Front" and
"Rear" volumes up by 10 to 20%.
6 Save the movie.

During playback, the telephone sound will seem to get louder as you "move" towards it, and quieter
as you "move" away from it.

Sound Range Trick
1 Create a sound sample and amplify the sample so that it is louder than usual.
2 Import the sample into SoundSaVR and set it to be directional.
3 Adjust the "Front" volume slider down to 10 or 20% and make sure the "Rear" is set to zero.
4 Save the movie.

During playback, as the movie is panned, the sound will  drop off much quicker than usual.



Audio Streaming Trick
In some cases you may wish to add a long silence to the beginning of your audio sample in order to
give it more time to download and lower the risk of data underrun or start / stop controller behav-
iour.
Lengthen Random Loop Delay Tip
Add a short  bit of "random" silence to the end of short audio samples you plan to set to "Random
Delay".  Doing this will increase the maximum length of the random delay.  Sounds under three
seconds have a max random delay of 5 to 6 seconds arbitrarily.

Offset Random Loop Delay Tip
Add a short  bit of silence to the beginning of audio samples you plan to set to "Random Delay",
using a different length for each.  Doing this will prevent the samples from starting simultaneously.

Looping Midi Tip
Incorrectly authored Midi (no NOTE OFF resets) will not loop correctly in SoundSaVR or in Movie
Player.

Use MoviePlayer or SimpleText to preview sounds in output movies after you export them. Open
output movies with another viewer after SoundSaVR creates them, without closing the SoundSaVR
editing window.

Reporting problems

SoundSaVR 2.0 is a completely redesigned from the ground up application. As a result of the wide
variety of different types of sound compressors, VR creation programs and system configurations, it
is expected that some conflicts and bugs are going to be found.

Please consult the FAQ for information on current SoundSaVR issues and bugs.   If you believe that
you have found a different problem, please ensure that you can reproduce it, and check if it still
occurs when starting up with only the required standard Apple extensions. Please also make sure
that all source movies and sounds play correctly in MoviePlayer before they are brought into
SoundSaVR.

If problems persist, please e-mail a detailed description of the problem, how it is triggered, and if
possible, an example source movie, as well as what program the movie was authored with, to
<dev@smgVR.com>



Fixes and Enhancements
April.22, 2000 - v2.0
• No more tile requirements.
• Preview mode added.
• Compatibility with VRworx multinodes.
• Object nodes can be present in multinodes.
• Directional sounds also use tilt info to determine volume.
• Removed advanced streaming options to prevent "dangerous" movie making.
• Custom themes can now be used in the Finder without problems.
• QT4.1 eliminates the extended play "broken icon" problem on Windows machines.

Sept.14, 1999 - v1.2
• MP3 audio tracks are now supported.
• A progress bar will now give feedback during lengthy saves.
• RTSP tracks can now by added like any other sound.  The video (if available) of the RTSP track

will be invisible.
• Choosing "Save As QuickTime Movie" from the browser plug-in popup menu will no longer

flatten the movie, bloating the movie's size and making it appear that the system has crashed.
• Added a workaround that increases the duration that a movie with directional sound will last in

Windows before the movie gets a "broken icon"   (See Troubleshooting section of the FAQ).

Oct. 19 1998 - v1.1
• Sprite Bonus Pack
• QTVR Tile Calculator HyperCard Stack
• Supports Fast Start for Internet with four loading options
• Supports looping with random length delays
• Now supports optional auto play / not play. Optional for each node
• Increased compatibility with multinode movies
• Node durations can now be less than one second
• Sound durations can now be less than one second

Sept. 19 1998 - v1.0
• Documentation and dialog messages stated that disabled output movies would play sounds from 0

to 100 degrees.  These items were corrected to indicate that  disabled output movies will play
sounds from 360 to 260 degrees.

  Updates & Upgrade Policy

• Version 2.0 release is free to version 1.X registered users
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